


LETTERTYPEN

Wanneer u gebruik maakt van programma´s zoals Adobe 

Illustrator™ of InDesign™, is het gewenst om de fonts in te 

sluiten wanneer u het uiteindelijke resultaat exporteert naar 

een PDF-bestand. Het insluiten van lettertypes wordt ook 

wel embedden genoemd. Dit embedden zorgt ervoor dat

het PDF-bestand als het ware uw gebruikte lettertypes

meeneemt zodat andere systemen uw bestand correct

kan weergeven, met de door u gebruikte lettertypes.

Echter prefereren wij dat alle tekst is omgezet naar lijn-

contouren zodat er absoluut geen sprake meer is van let-

tertypes maar van vectoren. Door dit te hanteren, is er in 

ieder geval de garantie dat er met betrekking tot lettertypes 

niks mis kan gaan.

In Illustrator™ of InDesign™ kunt u uw tekst omzetten naar 

lettercontouren. Dit doet u heel simpel in het menu van 

genoemde programma´s. U selecteert eerst alle tekst. 

Vervolgens gaat u naar het menu:

Type > Create Outlines
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Dit is een voorbeeld van de letter “a” doe is omgezet naar lijncontou-

ren in Adobe Illustrator TM.

Let wel dat na het omzetten, het niet meer mogelijk is om uw 

tekst te bewerken. Een tip is om dan twee versie’s op te slaan.



SPOTVERNIS

Drukwerk met een extra dimensie

U heeft er voor gekozen om uw drukwerk te voorzien van 

een matglanzende laag op specifieke plekken. Wij noemen 

dit ook wel spotvernis. Let wel dat deze techniek niet te 

verwarren is met spot-UV waarbij weer gebruik word ge-

maakt van hoogglans laag op specifieke plekken. Doordat in 

de digitaaldruk gebruik wordt gemaakt van matglans, is het 

resultaat minimaal t.o.v. hoogglans, wat in offset gebruikt 

word. Hierdoor raden wij u aan om spotvernis alleen op 

lichte kleuren te gebruiken. Op zwart of een afbeelding met 

verschillende kleuren zal spotvernis dus nauwelijks te zien 

zijn. Houd u hier rekening mee als u spotvernis wilt gebrui-

ken.

Hier treft u verschillende oefeningen waarbij gebruik word 

gemaakt van verschillende software om de spotvernis cor-

rect op te maken.

Vectoren als spotvernis met Illustrator of InDesign.

Eén van de manieren om spotvernis te verkrijgen is door 

met vector objecten te werken.

Dit doet u dan met programma’s als Illustrator of InDesign. 

In dit voorbeeld gebruiken we het programma Illustrator. 

Het menu van InDesign en de benodigde tools lijken nage-

noeg op dat van illustrator en zullen wij dus voor het gemak 

achterwege laten.

In ons voorbeeld gebruiken we een afbeelding van een sofa

(afbeelding 1) waar wij een patroon (afbeelding 2) over heen

willen “gooien”. Dit patroon zal dan de spotvernis zijn.

De machine, de Kodak Nexpress2500, heeft een herken-

ningspunt nodig waardoor de spotvernis geactiveerd

word. Hiervoor opent u het venster Swatches (afbeelding 3)

Window > Swatches

Vervolgens maakt u een nieuwe Swatch aan. U dubbelklikt

op de zojuist gecreeërde Swatch. (afbeelding 4) en geeft

het een willekeurige kleur naar wens. Vervolgens zorgt u

ervoor dat Spot color geselecteerd is.

Vervolgens geeft u de Swatch de volgende naam:

NexPress Dryink clear

U selecteert het patroon-object en past de gecreëerde

Swatch toe. Deze dient zich wel boven de afbeelding te

bevinden. Als laatste opent u het Transparency venster

(afbeelding 5) Window > transparency en met het

patroon-object nog geselcteerd, wijzigt u de transparantie 

van Normal in Multiply.
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SPOTVERNIS

Let op: de naam dient exact geschreven te worden als 

hierboven genoemd, met de juiste hoofdletters en spaties. 

Doet u dit niet dan zal de spotvernis niet werken.

Pixels als spotvernis met Adobe Photoshop

Bent u niet gewend om met vectoren te werken maar doet 

u alles het liefst met Photoshop, dan is onderstaande uitleg 

om spotvernis te verkrijgen voor u.

In ons voorbeeld gebruiken we een ticket (afbeelding 1) die

“beveiligd” word d.m.v. een logo of patroon (afbeelding 2).

Deze toepassing wordt vaak gebruikt om illegale kopie’s van

bijvoorbeeld tickets tegen te gaan.

De machine die de spotvernis zal gaan verwerken heeft een

herkenningspunt nodig waardoor deze geactiveerd word. 

Hiervoor opent u het venster Channels:

Window > Channels

Vervolgens maakt u een nieuwe SPOT CHANNEL (afbeelding 

3)

Hierna krijgt u een nieuw venster te zien. De kleur verandert 

u naar wens of u laat deze voor wat het is.

Solidity laat u gewoon op 0% staan. Vervolgens verandert 

u de naam in het volgende: (afbeelding 4) NexPress DryInk 

clear.

U keert terug naar uw “lagen” venster:

Window > layers en u maakt een nieuwe laag aan. Vervol-

gens maakt u een selectie (afbeelfing 5) van het patroon. 

Deze selectie zal uiteindelijk de spotvernis worden. Het is 

dus niet zo dat de afbeelding zelfs als spotvernis zal gaan 

werken, maar een selectie hiervan!

Vervolgens bewaart u uw selectie:

select > save selection

In het volgende venster kiest u bij Channel voor de gemaakte

Spot Channel: Nexpress Dryink clear. De overige instellingen 

laat u voor wat het is en klikt op OK.

Om uw bestand goed te kunnen verwerken, dient u het op 

te slaan als PDF bestand.
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STICKERS

Let op: de naam dient exact geschreven te worden als 

hierboven genoemd, met de juiste hoofdletters. Doet u dit 

niet dan zal het snijpad niet werken.

Stickervormen opmaken om uit te snijden

Bij ons heeft u de mogelijkheid om stickers te laten maken 

met verschillende vormen. Denkt u aan die stickervellen met 

bekende cartoonfiguren erop, bestemd voor kinderen om in 

hun vriendenboek te plakken. Of op maat gemaakte etiketten 

voor uw nieuwe parfumlijn. De mogelijkheden gaan zover uw 

creativiteit gaat. Om deze vormen te verkrijgen is het ook 

hier weer van belang dat uw bestand correct is opgemaakt.

De machine die deze stickers verwerkt is een Roland Soljet 

Pro3 XC-540. Deze machine kan niet alleen (grootformaat) 

printen, maar is ook voorzien van een cutting-unit, oftewel 

een snijmechanisme. Wanneer wij het (sticker)bestand naar 

deze machine sturen zal hij alleen het beeld printen. Wat we 

willen is dat het beeld ook word uitgesneden. De machine 

herkent dit doordat er in het bestand een snijpad is aan-

gemaakt. Dit snijpad is dus afzonderlijk van het te printen 

beeld opgemaakt. Ook hier maken we gebruik van Adobe 

Illustrator™.

De juiste benaming

In dit voorbeeld maken we gebruik van een illustratie. 

(afbeelding 1) Deze word weer iets groter uitgesneden met 

een vooraf met de Pentool gemaakte snijpad. (afbeelding 2) 

Zorg ervoor dat dit snijpad geheel gesloten is. Zonder dat 

een object is geselecteerd, geeft u de Stroke een willekeu-

rige kleur. (afbeelding 3) Vervolgens opent u het Swatches 

venster indien dit nog niet het geval is.

Window > Swatches

Vervolgens maakt u een nieuwe Swatch (afbeelding 4) aan. 

U dubbelklikt op de nieuwe swatch en als u het juist heeft 

gedaan, ziet u dat deze

de kleur heeft die u heeft aangemaakt. Zorg er voor dat 

Spot Color is geselecteerd. De naam verandert u in het 

volgende:

CutContour

Vervolgens selecteert u het snijpad en past de zojuist ge-

maakte Swatch erop toe. (afbeelding 5) Zorg ervoor dat de 

Swatch geen vulling, maar een lijn is. De sneltoets hiervoor 

is shift+x of voor een Mac: Apple+x. De vulling laat u trans-

parant. Vervolgens opent u het Stroke venster:

Window >Stroke

Met het snijpad nog geselecteerd, geeft u de lijn, oftewel 

stroke, een gewicht van 0,25pt. Als laatste slaat u uw werk 

als EPS op. Let op: Illustrator 10 EPS!

Het kan zijn dat wanneer u Adobe 

CS2 gebruikt, u de waarde van 

0,25pt handmatig dient in te voe-

ren. Direct selecteren werkt vreemd 

genoeg in sommige versies niet.
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ANSICHTKAARTENKAARTEN

Bij dubbelzijdig drukwerk is het eigenlijk vanzelfsprekend dat 

wanneer beide kanten worden opgemaakt, deze gewoon 

rechtop staan. Maar wanneer er sprake is van een wens-

kaart, waarbij de kaart wordt dubbelgevouwen waardoor 
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Buitenkant; voor- en achter-

kant. Let op dat u de achter-

kant ondersteboven opmaakt 

in uw favoriete software.

Binnenkant; onder en boven. 

De achterkant van 2 is in 

feite de voorkant, pagina 1.

Voor beide voorbeelden geldt dat u de pagina’s 1,2,3 en 4 apart kunt op-

maken en kunt aanleveren. Wij zorgen er dan voor dat de plaatsing klopt. 

U kunt echter ook spreads aanleveren wanneer er bijvoorbeeld sprake is 

van een doorlopend beeld. U levert dus pagina 1 en 4 gezamenlijk en/of 

2 en 3 gezamenlijk als één ontwerp aan. In het laatste geval is het van 

belang dat u deze voorbeelden aanhoudt.

Buitenkant; voor- en achterkant. 

Deze versie spreekt voor zich.

Binnenkant; links en rechts. In de voorbeelden wordt 

een stippellijn gebruikt om de vouw weer te geven. 

            Let op dat u deze niet in uw ontwerp meeneemt.

deze ergens op kan rusten, is er vaak verwarring met het 

aanleveren. Onderaan treft u een in zijn geheel geïllustreer-

de uitleg wat hopelijk voor verheldering zorgt.
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canvas

7,5 cm  afloop aan elke zijde.

40 cm + 15 cm Afloop = 55 cm

40
 c
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cm

Canvas
Doek

Bruto formaat

Snijlijn

Tekst venster 

Maat

LEGENDA

cm

Canvasdoek
Bruto formaat:  55 cm x 55 cm
Netto formaat:  40 cm x 40 cm 

Tekst  0,5 cm van netto formaat 
De tekst dient u 0,5 cm van de rand van het netto formaat af te plaatsen,
dus in totaal 8 cm van de rand van het bruto formaat  

Doorgaans heeft drukwerk een afloop nodig van 3 mm aan 

elke zijde. Bij het drukken van een canvasdoek geldt eigenlijk 

hetzelfde principe, alleen is er geen sprake van 3 mm maar 

2,5 cm. Houd u er dan ook tijdens het opmaken van uw 

document rekening mee dat er 2,5 cm “wegvalt”. (zijkant 

van het doek)

In tegenstelling tot ander drukwerk waar de afloop wordt 

schoongesneden, wordt de “afloop” van 2,5 cm hier ge-

bruikt om het doek af te maken. Waarschijnlijk heeft u het al 

door, maar deze 2,5 cm is de rand van het doek. Er is vaker 

de vraag gesteld of de rand dan niet beter wit gelaten kan 

worden. Dit raden wij af omdat het opspannen van een doek 

nog altijd “handenarbeid” is en het een hele karwei is om het 

beeld exact gespannen te krijgen zodat deze mooi gecen-

treerd staat. Doordat u 2,5 cm extra marge opmaakt, geeft 

u ons de ruimte om daarin te schuiven. Daarnaast is het 

mooier wanneer ook de randen zijn bedrukt.
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BROCHURES

Voor het opmaken van een brochure is het algemeen 

bekend dat u dit het beste kunt doen met Adobe 

InDesign™ of QuarkExpress™. Bent u al bekend met 

het produceren van brochures, dan is de term inslag-

schema geen onbekende voor u. Dit is een specifieke 

wijze van ordenen waardoor de bladzijdes uiteindelijk 

op volgorde worden gedrukt. Indien u hier niet bekend 

mee bent, vreest u niet, want op inslagschema

aanleveren is niet nodig! De meeste drukkers vragen 

om een bestand op inslagschema. Bij ons wordt uw 

bestand automatisch op inslagschema ingedeeld

op onze drukpers.

Dit betekent voor u dat u uw bestand gewoon op volg-

orde dient aan te leveren. M.a.w. uw bestand dient 

losse pagina´s te bevatten, dus ook geen spreads.

Kortom, u dient 1 bestand (pdf) aan te leveren waar-

bij de pagina’s onder elkaar staan. Wel op de juiste 

volgorde.

          N.B. iedere pagina met 3 mm opmaken.


1

2

14


2 3

Fout: inslagschema is niet nodig en 

a.u.b. geen spreads.

Goed: alle pagina’s 

afzonderlijk.

Pagina’s onder elkaar (beeld uit InDesign).
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VISITEKAARTJES

Bij het certificeren en/of opmaken van visitekaartjes 

komt er ook het een en ander kijken.

Wanneer er een visitekaartje in offset gedrukt dient 

te worden (oplages vanaf 625) is het belangrijk wan-

neer de opmaak staand is dit dan ook staand aan te 

leveren. Wanneer de opmaak liggend is dien je dit ook 

liggend aan te leveren. 

Bij het digitaal drukken van visitekaarten (oplages 

vanaf 50) is dit een ander verhaal.

Wanneer de opmaak liggend is moet het liggend aan-

geleverd te worden. 

Wanneer de opmaak staand is, wordt het een heel 

ander verhaal. Hier dient de voorkant linksom ge-

draaid te worden en de achterkant rechtsom.

Zie de afbeeldingen voor een beter overzicht:

VOORKANT ACHTERKANT

VOORKANT ACHTERKANT

V
O
O
R
K
A
N
T

A
C
H
TER
K
A
N
T

Digitaal drukwerk

offset drukwerk
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werktekeningen

Alle werktekeningen zijn te vinden op de website: 
www.drukwijzer.nl. Als u doorklikt komt u vanzelf de 
digitale werktekeningen tegen.

Voor alle enveloppen geldt dat de bovenkant 11 mm 
niet bedrukt kan worden. Overigens dient u er ook 
rekening mee te houden dat rondom het venster 
een witruimte van 2 mm zal ontstaan.

220 mm + 6 mm afloop = 226 mm

15
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 m
m
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 =
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59
 m

m

3 mm  a�oop aan elke zijde.

11 mm LET OP: bovenzijde wordt niet a�opend gedrukt

50 mm

66 mm

20mm

Tekst  5 mm van netto formaat
De tekst dient u 5 mm van de rand van het netto formaat af te plaatsen,
dus in totaal 8 mm van de rand van het bruto formaat

40 mm x 110 mm

EA5 Bruto formaat

Snijlijn

Vouwlijn

Tekst venster 

Maat

LEGENDA

mmEA5
Bruto formaat:  226 mm x 159 mm
Netto formaat:  220 mm x 156 mm 

2 mm witruimte rondom 
het venster houden

40 mm x 110 mm
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WERKTEKENINGEN

Tekst 5 mm van netto formaat   
De tekst dient u 5 mm van de rand van het netto formaat af te plaatsen,   
dus in totaal 8 mm van de rand van het bruto formaat   

 

215 mm55 mm3 mm afloop 3 mm afloop

3 mm afloop

3 mm afloop

300 mm 306 mm

306 mm

40 mm

215 mm

491 mm

Tekst 5 mm van netto formaat  

491 mm

De tekst dient u 5 mm van de rand van het netto formaat af te plaatsen,   
dus in totaal 8 mm van de rand van het bruto formaat   

215 mm 55 mm 3 mm afloop3 mm afloop

3 mm afloop

3 mm afloop

300 mm

40 mm

215 mm

Aangeleverde formaat: 306 x 491 mm
Schoongesneden formaat: 300 x 485 mm Presentatiemappen
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AANLEVEREN

Wij hopen dat u hiermee genoeg informatie heeft ge-

kregen omtrent het aanleveren van juiste bestanden.

Mocht u nog verdere vragen hebben met betrekking 

tot het aanleveren van uw bestanden dan kunt u te 

allen tijde mailen naar:

bestanden@drukwijzer.nl

Uiteraard mag u van ons meer verwachten dan van 

overige drukkers.

Daarom controleren wij uw bestanden altijd grondig, 

en dat is anders dan andere (internet)drukkers.

Onze ervaren DTP-studio (in huis) met meer dan 

20 jaar ervaring weet hoe je een technisch perfect 

drukbestand opmaakt en controleert. Desgewenst 

voeren wij een kleine correctie uit, zonder extra kos-

ten. Want kwaliteit staat bij Drukwijzer voorop; Uw 

perfecte drukresultaat is ons visitekaartje.

Wilt u overigens technische informatie of advies over 

de opmaak van uw document, bel dan onze DTP-

Studio op 0900 - DRUKWIJZER. Miranda, Mark en 

Robert staan voor u klaar. Wat zij niet weten is de 

moeite van het onthouden niet waard!
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